
159

©Northwest Association for Biomedical Research—Updated October 2012

LESSON 5

Protein Structure and Function: 
A Molecular Murder Mystery5
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Class Time

1 class period of 50 minutes. 

Prior Knowledge Needed 

•	 How to open a file in Cn3D.

•	 Basic knowledge of protein structure, 

including one-letter abbreviations 

for amino acids and alpha helices/

beta sheets. [Note: One-letter 

abbreviations can be found in the 

Circular Codon Table found in Lesson 

Four and in the Appendix.]

Introduction

Prior to this lesson, students learned how the cytochrome c oxidase subunit 1 
(COI) gene is used to barcode animals. In this lesson, students learn more about 
the cytochrome c oxidase protein and its three dimensional structure. In particular, 
students learn how to identify the active site in cytochrome c oxidase. Once they 
can find this site, they look at aligned structures (one of which contains a poison) 
and then determine the identity of a foreign substance that acts as a poison by 
binding to the active site. This lesson allows students to explore the use of the 
molecular visualization program Cn3D to learn more about cytochrome c oxidase, 
a ubiquitous and important protein. In Lesson Five, students also learn how 
molecular diagnostics researchers might use bioinformatics tools in their career.

Learning Objectives

At the end of this lesson, students will know that:

• The mitochondria are the site of ATP production in the cell.

• The cytochrome oxidase complex is involved in ATP production, and is located 
in the inner mitochondrial membrane.

• Some poisons, such as carbon monoxide, act by binding to the active site of 
enzymes, preventing them from functioning.

At the end of this lesson, students will be able to:

• View the cytochrome c oxidase protein in Cn3D.

• Identify the active site of the cytochrome c oxidase protein in the three-
dimensional structure.

• Characterize a poison (carbon monoxide or cyanide) bound to the active site 
of the protein.

Key Concepts
• Proteins have multiple levels of structure: primary (the sequence of amino 

acids), secondary (characteristic structures such as alpha helices and beta 
sheets that are formed by interactions between neighboring amino acids), 
tertiary (includes more distant interactions and domains) and quaternary 
(interactions between multiple peptide chains). The tertiary structure can be 
seen as the three-dimensional (3D) structure of a single protein chain, whereas 
the quaternary structure represents a larger assembly of one or more proteins 
and is composed of multiple protein chains/subunits.

• The active site of a protein is important for its function.

• Substances that can bind to the active site and block access by its normal 
substrate can interfere with protein function.
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Materials

Computer Equipment, Files, Software, and Media

Computer and projector to display PowerPoint slides.
Alternative: Print PowerPoint slides onto transparencies and display with overhead projector.

Lesson Five PowerPoint Slides—Molecular Murder Mystery. Available for download at: 
http://www.nwabr.org/curriculum/advanced-bioinformatics-genetic-research.

Lesson Five protein structure files for Part II. Available for download under the “Resources” tab at: 
http://www.nwabr.org/curriculum/advanced-bioinformatics-genetic-research.

A student version of lesson materials (minus Teacher Answer Keys) is available from NWABR’s Student Resource Center at:
http://www.nwabr.org/students/student-resource-center/instructional-materials/advanced-bioinformatics-genetic-research.

Online video, “Electron-Transport Chain,” produced by Garland Science. The video is 2:17 minutes long. Available at:
http://www.youtube.com/watch?v=KXsxJNXaT7w&feature=related.

Computer lab with internet access, the program Cn3D, and a word processing program such as Google® Docs or Microsoft® 
Word for answering lesson activity and homework questions. [Note: Students are asked to insert images of protein structures 
into their homework document, which cannot be accomplished with a plain text editing program like Notepad.]

Materials Quantity

Copies of Student Handout—Careers in the Spotlight (handed out in Lesson One) 1 per student

Copies of Student Handout—The Process of Genetic Research (handed out in Lesson One) 1 per student

Class set of Student Handout—Codons and Amino Acid Chemistry (from Lesson Four, printed 
in color if possible)

1 per student (class set)

Class set of Student Handout—Molecular Murder Mystery Instructions 1 per student (class set)

Teacher Answer Key—The Process of Genetic Research (found in Lesson One) 1

Teacher Answer Key—Molecular Murder Mystery 1

Teacher Resource—Installing Cn3D
[Note: If students will be asked to install Cn3D, make a class set of copies of this handout.]

1 
– or –

1 per student (class set)

LESSON 5

Teacher Preparation
•	To maximize class time for the lesson activities, it will be useful to install the 

Cn3D program as well as the structure files for Student Handout—Molecular 
Murder Mystery on classroom computers prior to class. See Teacher 
Resource—Installing Cn3D for complete instructions on installing Cn3D. 
Alternatively, make a class set of the resource pages and have students 
install the program. [Note: The IT departments of some schools or districts 
require significant lead time to install or approve installation of programs on 
school computers.]

•	Load the classroom computer with the Lesson Five PowerPoint slides.

•	Make copies of Student Handout—Molecular Murder Mystery, one per 
student. This handout is designed to be re-used as a class set.
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Procedure

Warm Up

1. As students enter the classroom, display the PowerPoint slide for Lesson Five, 
beginning with Slide #1. This slide highlights James Ferrenberg, a molecular 
diagnostics researcher.

 

2. Have students retrieve Student Handout—Careers in the Spotlight, which they 
were given during Lesson One. 

3. Students should think about, and write down, what kind of work a molecular 
diagnostics researcher might do (Molecular Diagnostics Researcher Question 
#1). This will be revisited at the end of the lesson, including how a molecular 
diagnostics researcher might use bioinformatics in his or her job.

4. Tell students to keep their Careers in the Spotlight Handout available for 
future lessons.

PART I: Mitochondria – The Powerhouses of the Cell

5. Explain to students the aims of this lesson. Some teachers may find it useful 
to write the aims on the board. 

a. Lesson Aim: Understand that protein structure can impact protein 
function, using the bioinformatics tool Cn3D to visualize molecules.

b. Lesson Aim: Explore the structure and active site of the COI protein, 
encoded in part by the barcoding gene.

Teachers may also wish to discuss the Learning Objectives of the lesson, which 
are listed at the beginning of this lesson plan.

6. Remind students that the cytochrome c oxidase subunit 1 or “COI” gene 
used for barcoding is found in the mitochondria.

Bioinformatics & Protein Structure: Slide #1

Cytochrome c oxidase subunit 1 

(COI): COI is the cytochrome c oxidase 

subunit 1 gene. COI encodes the COI 

protein found in the electron transport 

chain. The entire cytochrome c oxidase 

protein complex is composed of two 

copies of 13 different protein chains 

(subunits 1–13). Subunit 1 contains the 

enzyme’s active site. The sequence of 

cytochrome C oxidase subunit 1 (COI) is 

similar in all living creatures, and is used 

for DNA barcoding of animals.

Mitochondria: A part of the cell 

(organelle) containing enzymes 

responsible for producing energy in the 

form of ATP (adenosine triphosphate).
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7. Show Slide #2, and convey to students the following information:

• The function of the mitochondria is to convert food (in the form of sugars 
and fats) into energy (in the form of ATP) which is used to power almost all 
of the functions needed by life.

• Mitochondria are found in almost every cell in the body, because all cells 
need energy (ATP).

• Mitochondria contain an outer membrane and an inner membrane 
(similar to the membrane that surrounds the whole cell), as well as their own 
DNA, which encodes genes specific to the mitochondria, including COI.

• The very center of the mitochondrion is called the matrix and the space 
between the two membranes is called the intermembrane space.

8. Show Slide #3, and convey to students the following information:

• The electron transport chain has many different protein components that 
are found in the inner mitochondrial membrane.

• These proteins are called transmembrane proteins because they are 
found inside the membrane, with part of the protein sticking out on 
either side. The cytochrome c oxidase (COI) protein is one of these 
transmembrane proteins. The vital role COI plays in making ATP helps 
explain why COI is highly conserved, meaning it is found in all species, 
without many changes or mutations.

• The proteins of the electron transport chain pump positively-charged 
protons (also called hydrogen ions) from the intermembrane space into 
the matrix, and create a concentration gradient. Like water pumped 
uphill, when these protons flow back across the inner membrane through 
channels called ATP synthase, the energy of the proton flow is used to 
make ATP.

• The portion of the protein where chemical reactions take place is called 
the active site.

Bioinformatics & Protein Structure: Slide #2

Outer membrane: Phospholipid 

membrane surrounding and containing 

the mitochondrion.

Inner membrane: Membrane found 

inside the mitochondrion that contains 

the proteins involved in the electron 

transport chain and ATP synthesis. 

Matrix: Space inside the inner 

membrane of the mitochondrion.

Intermembrane space: Space between 

the inner and outer mitochondrial 

membranes.

Electron transport chain: A series of 

proteins found in the inner membrane 

of the mitochondria that couples 

chemical reactions to produce adenine 

triphosphate (ATP), which is the energy 

source used by cells.

Transmembrane proteins: Proteins 

embedded in and spanning a 

phospholipid bilayer or membrane.

Conserved: DNA or protein sequences 

are said to be “conserved” if the 

sequences are the same or very similar. 

Proton: Subatomic particle with an electric 

charge of +1. Also called a hydrogen ion.

Concentration gradient: In biology, 

a gradient results from an unequal 

distribution of ions across a cell 

membrane. When this happens, solutes 

move along a concentration gradient. This 

kind of movement is called diffusion.

ATP synthase: Transmembrane protein 

in the inner mitochondrial membrane 

that uses the concentration gradient of 

protons across the membrane to fuel the 

production of ATP.

LESSON 5
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9. Show students the following video, which provides a brief overview of the 
electron transport chain in action. The video can be found at: 

Electron-Transport Chain Video (2:17 minutes)
http://www.youtube.com/watch?v=KXsxJNXaT7w&feature=related

10. Tell students that scientists (and textbook authors!) often draw proteins as 
simple boxes or other two dimensional shapes for simplification. However, 
each protein is much more complicated, containing hundreds and sometimes 
thousands of amino acids. 

11. Show Slide #4, which shows the three-dimensional crystal structure of 
the two copies of the 13 subunits of the cytochrome c oxidase complex 
embedded in the inner mitochondrial membrane. The COI protein is 
subunit number 1 of this complex. Each subunit is shown in a different 
color. The top of the structure faces into the intermembrane space. The 
bottom of the structure faces into the mitochondrial matrix. The coils 
represent alpha helices and the flat arrows are beta sheets.

Bioinformatics & Protein Structure: Slide #3

Bioinformatics & Protein Structure: Slide #4

Active site: The site in an enzyme where 

chemical reactions take place. This is 

often a cleft or pocket on the surface of 

the enzyme. Also called the functional or 

catalytic site. 

Complex: A group of two or more 

proteins that associate with one another 

and work together to accomplish some 

function. [Note: “Complexes” is the 

plural form of “complex.”]

Cytochrome c oxidase complex: One 

of the protein complexes found in the 

mitochondria, which contain proteins 

(cytochromes) involved in the production 

of ATP (adenosine triphosphate).

Alpha helix: A common structure in 

proteins, characterized by a single, 

spiral chain of amino acids stabilized by 

hydrogen bonds between neighboring 

amino acids. [Note: “Alpha helices” is 

the plural form.]

Beta sheet: A structure that occurs 

in many proteins and consists of two 

or more parallel adjacent polypeptide 

chains arranged so that hydrogen bonds 

can form between the chains.

[Note: These are the same secondary 

structures that students saw when 

they viewed the BRCT domain from 

the BRCA1 protein in Lesson Five of 

the Introductory curriculum, Using 

Bioinformatics: Genetic Testing.]
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12. Ask students why understanding a protein’s structure is important. Have 
them talk to their neighbor for one minute to brainstorm ideas about this 
question.

13. Lead a discussion on the relationship between structure and function. Key 
points to cover include:

• Understanding a protein’s structure allows scientists to learn more about 
how that protein functions. 

• Understanding the structure also reveals how changes to that structure can 
impact function.

• When the protein studied is from an infectious disease-causing organism 
like influenza, or is a protein involved in diseases like cancer, understanding 
the protein’s structure can help scientists develop diagnostic tests and 
drugs to treat the disease. This is the type of work performed by molecular 
diagnostics researchers.

PART II: Molecular Murder Mystery—Cytochrome c Oxidase 

14. Share with students that they will take a closer look at the three-dimensional 
structure of cytochrome c oxidase.

15. Distribute copies of Student Handout—Molecular Murder Mystery, one per 
student.

16. Advise students as to whether they will need to download Cn3D and the 
structure files or whether you have already done so.

17. Briefly review the two main sections of Student Handout—Molecular 
Murder Mystery and what students are expected to do:

• In the first section, students investigate the overall structure of the protein. 
In the second section, they examine two overlapping structures – one that 
contains a poison and one that does not.

• Their goal is to identify the poison that killed their victim, which can readily 
be done using their knowledge of the way elements are color coded in 
Cn3D. Along the way, they will capture images from the computer screen 
to document their progress. 

• Students will need to create word processing documents using a program 
such as Google® Docs or Microsoft® Word. Specify how you wish students 
to turn in their files to you. For example, they may print out the document if 
a printer is available, or save the file to a shared folder.

18. Assign each student to investigate either Carol Olds or Carl North. 

19. You may want the class to stop working on the handout when they have 
finished Part I, in order to review the overall structure of the protein and 
the characteristics of the active site as a class before allowing students to 
proceed with Part II. If students are struggling with Part II, you may wish to 
demonstrate how to highlight the Fe/heme, Cu, and poisons using a projector, 
or walk through Part II with students as a class.

[Note: The initials of each victim 

correspond to the poison used; this 

has been done for ease of teacher 

identification. However, do not reveal 

this to students yet!]

LESSON 5



165

©Northwest Association for Biomedical Research—Updated October 2012

Closure

20. Summarize today’s lesson: 

• Students have learned how to use a molecular visualization program, Cn3D, 
to investigate the structure of the cytochrome c oxidase protein and its 
active site. 

• They have learned how the structure of a protein can provide insights into 
how that protein functions. 

• They have also learned how a protein’s function can be disrupted by a 
poison binding to the active site.

21. If your students have participated in the Using Bioinformatics: Genetic 
Testing lessons, you may wish to connect this lesson to their prior knowledge 
about protein structure. In particular, protein function can be impacted by 
mutations, which change the amino acid sequence and, in some cases, 
can alter the protein structure. However, in this example, protein function is 
impacted when other molecules (poisons) block the active site and prevent the 
normal substrates from binding.

22. You may wish to review the answers to the murder mystery with the class or 
wait until the beginning of the next class period.

23. Ask students to fill out the section about Lesson Five on Student Handout—
The Process of Genetic Research, which was handed out during Lesson One. 
Students could also answer these questions in their lab notebooks:

• What did you do in this lesson?

• Methods: What bioinformatics tool(s) and/or database(s) did you use? 

• Results & Conclusions: What did you find? What could you conclude from 
your analysis?

• What skills did you learn or practice?

24. Lastly, show Slide #5, which returns to the picture of the molecular 
diagnostics researcher from Slide #1. 

 

Mutation: A change in a DNA or 

protein sequence.

Bioinformatics & Protein Structure: Slide #5
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25. Show Slide #6, which provides job information for a molecular diagnostics 
researcher. Review this information with students.

26. Ask students, “What more do we know about molecular diagnostics 
after today’s lesson?” Point out that molecular diagnostic researchers use 
genetic research and insights into protein structure to study infectious 
agents like influenza, and to develop laboratory tests to diagnose 
infectious organisms in human and animal patients. Understanding protein 
structure can also be instrumental in helping scientists develop drugs 
to treat infectious diseases. These drugs act in a manner similar to the 
poisons in this activity. They bind to the active site of an important protein 
and block the normal chemical reactions that would take place.  In the 
case of carbon monoxide or cyanide binding to COI, carbon monoxide 
binds to the COI active site, preventing oxygen from binding. The overall 
effect is that COI can no longer carry out its normal function.

27. Ask students to answer Molecular Diagnostic Researcher Question #2 on 
their Careers in the Spotlight Handout, which has students explain how this 
lesson has changed their understanding of what kind of work a molecular 
diagnostic researcher does.

28. Ask students to also answer Molecular Diagnostic Researcher Question #3 
on their Careers in the Spotlight Handout, which has students explain how a 
molecular diagnostic researcher might use bioinformatics in his or her work.

29. Tell students to keep their Careers in the Spotlight Handout available for 
future lessons.

Bioinformatics & Protein Structure: Slide #6

LESSON 5
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Homework

A. As homework, ask students to write about the activities they worked on in 
Lesson Five in their Lab Notebooks, on another sheet of paper, or in a word 
processing program like Notepad or Microsoft Word® which they then provide 
to the teacher as a printout or via email. This can serve as an entry ticket for 
the following class. Have them complete these prompts:

a. Today I learned that…

b. An important idea to think about is…

c. Something that I don’t completely understand yet is…

d. Something that I’m really confident that I understand is….

B. The Lesson Five Section of Student Handout—The Process of Genetic 
Research could also be assigned as homework. 

Extension

For more experiences with Cn3D, including structures with additional poisons, 
see “A Murder Mystery with Molecular Structures” in the “Tutorials” section at 
Digital World Biology: http://www.digitalworldbiology.com/dwb/Home.html

Glossary

Active site: The site in an enzyme where chemical reactions take place. This is often a cleft or pocket on the surface of the 
enzyme. Also called the functional or catalytic site. 

Adenosine Triphosphate (ATP): The molecule that is the source of energy for most life processes in living organisms.

Alpha helix: A common structure in proteins, characterized by a single, spiral chain of amino acids stabilized by hydrogen 
bonds between neighboring amino acids. [Note: “Alpha helices” is the plural form.]

ATP synthase: Transmembrane protein in the inner mitochondrial membrane that uses the concentration gradient of protons 
across the membrane to fuel the production of ATP.

Beta sheet: A structure that occurs in many proteins and consists of two or more parallel adjacent polypeptide chains 
arranged so that hydrogen bonds can form between the chains.

Complex: A group of two or more proteins that associate with one another and often work together to accomplish some 
function. [Note: “Complexes” is the plural form of “complex.”]

Concentration gradient: In biology, a gradient results from an unequal distribution of ions across a cell membrane. When this 
happens, solutes move along a concentration gradient. This kind of movement is called diffusion.

Conserved: DNA or protein sequences are said to be “conserved” if the sequences are the same or very similar (i.e., if the 
amino acids have similar chemistries in the case of proteins). 

Copper: Copper is a metal element, whose symbol is Cu. The atomic number for copper is 29. 

Cytochrome c oxidase subunit 1 (COI):  COI is the cytochrome c oxidase subunit 1 gene. COI encodes the COI protein found 
in the electron transport chain. The entire cytochrome c oxidase protein complex is composed of two copies of 13 different 
protein chains (subunits 1–13). Subunit 1 contains the enzyme’s active site. The sequence of cytochrome C oxidase subunit 1 
(COI) is similar in all living creatures, and is used for DNA barcoding of animals.
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Cytochrome c oxidase complex: One of the protein complexes found in the mitochondria, which contain proteins 
(cytochromes) involved in the production of ATP (adenosine triphosphate).

Dimer: A structure made of two subunits called monomers.

Electron transport chain: A series of proteins found in the inner membrane of the mitochondria that couples chemical 
reactions to produce ATP (adenosine triphosphate), which is the energy source used by cells.

Elements: Elements are pure chemical substances consisting of one type of atom. Each element is distinguished by its atomic 
number. All the elements are listed in the periodic table.

Enzyme: A type of protein that catalyzes (increases the rate of) chemical reactions. For example, ATP synthase is an enzyme 
that catalyzes or facilitates the creation of ATP (adenosine triphosphate). 

Heme: A non-protein compound that contains iron and is vital to the function of the cytochrome c oxidase complex.

Hemoglobin: Iron-containing protein in red blood cells that carries oxygen.

Inner membrane: Membrane found inside the mitochondrion that contains the proteins involved in the electron transport 
chain and ATP synthesis. 

Intermembrane space: Space between the inner and outer mitochondrial membranes.

Iron: Iron is a metal element whose symbol is Fe. The atomic number for iron is 26. 

Matrix: Space inside the inner membrane of the mitochondrion.

Medical examiner: Qualified government official whose duty it is to investigate deaths and injuries that occur under unusual 
or suspicious circumstances.

Mitochondria: A part of the cell (organelle) containing enzymes responsible for producing energy in the form of ATP 
(adenosine triphosphate).

Monomer: A molecule or subunit that can combine with other monomers to form a polymer. “Mono” means “one” and 
“poly” means “many.”

Mutation: A change in a DNA or protein sequence.

Outer membrane: Phospholipid membrane surrounding and containing the mitochondrion.

Oxidative phosphorylation: The process of using oxidation to provide energy for adding the phosphate groups in ATP. This 
takes place in the mitochondria.

PBD number: A unique identifier or code assigned to every entry in the Protein Data Bank (PDB). This unique code can be 
used to search the databases at the National Center for Biotechnology Information (NCBI) to find the structure of interest.

PDB position: “PDB” stands for “Protein Data Bank.” The “PDB Position” or “PDB Number” is the position of a particular 
amino acid in a polypeptide chain.

Proton: Subatomic particle with an electric charge of +1. Also called a hydrogen ion.

Transmembrane proteins: Proteins embedded in and spanning a phospholipid bilayer or membrane.

LESSON 5
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Resources

Carbon monoxide. Wikipedia. Available at: http://en.wikipedia.org/wiki/Carbon_monoxide 

Cyanide. Wikipedia. Available at: http://en.wikipedia.org/wiki/Cyanide

Credit

Ferrenberg, James. Personal Interview. 14 July 2010.

Tsukihara, T., Aoyama, H., Yamashita, E., Tomizaki, T., Yamaguchi, H., Shinzawa-Itoh, 
K., Nakashima, R., Yaono, R., & Yoshikawa, S. The whole structure of the 13-subunit 
oxidized cytochrome c oxidase at 2.8 Å. Science. 1996; 272: 1136–44.

The authors wish to thank Wikimedia Commons for many of the images found in 
this lesson.

[Note: It should be noted that proteins 

in this activity are from cows, not 

humans, but the structures would be 

almost identical.]
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CLASS SET

Molecular Murder Mystery Instructions5
Medical examiner: Qualified 

government official whose duty 

it is to investigate deaths and 

injuries that occur under unusual 

or suspicious circumstances.

Active site: The site in an 

enzyme molecule where the 

substrate binds and where the 

reaction is facilitated. It is often 

a cleft or pocket on the surface 

of the enzyme. Also called a 

functional or catalytic site. 

Enzyme: A type of protein that 

catalyzes (increases the rate of) 

chemical reactions. For example, 

ATP synthase is an enzyme 

that catalyzes or facilitates the 

creation of ATP. 

Student Medical Examiner Background:

Aim: To understand that protein structure can impact protein function, 
using the bioinformatics tool Cn3D to visualize molecules.

The Situation: Two individuals were found dead at the scene of 
a crime. As the medical examiner, it is your job to find out 
how they died. 

At 1:05 AM on July 5, 2010, several guests at the Hotel Aurora in Seattle, 
Washington called 911 to report a loud crash in a nearby room. When 
paramedics and police arrived 8 minutes later, they found the bodies 
of two victims: Carol Olds and Carl North, both age 35. They had been 
visiting Seattle to see the 4th of July fireworks on Lake Union. 

While there were no obvious signs of foul play, both victims had 
apparently eaten a late dinner after the fireworks celebration, as 
evidenced by the empty dinner plates on the room service cart, which was 
delivered by hotel staff shortly after midnight. The crash heard by hotel 
guests was apparently one or more of the victims falling to the floor.

You suspect poison. The question is, which poison or poisons? Some 
poisons are known to bind to the active site of the cytochrome c oxidase 
protein complex. 

Your Challenge: Today, your job as a medical examiner is to:

1. Examine the structure and active site of the normal COI protein so that you can recognize it later when 
you examine samples from the victims.

2. Find the active sites in the protein structures obtained from blood samples taken from the bodies at the crime 
scene, to determine whether the samples contain a poison.

Instructions: Before you begin, be sure that the program Cn3D is installed on your computer. If the program 
has not been installed, ask your teacher for directions. Also make sure that you have access to a word 
processing program like Google® Docs or Microsoft® Word.

PART I: Investigating Cytochrome c Oxidase and its Active Site

1. Open the cytochrome c oxidase structure by following the directions below. Your teacher will let you know 
whether you should download the structure from NCBI or whether it is already downloaded. If you need to 
download it, follow these instructions:

a. Search for “NCBI Structure” in your internet browser.
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b. On the NCBI Structure Page, enter “1OCC” into 
the search bar (use letter O, not zero). This is the PBD 
number (or identifier) for the protein structure for 
cytochrome c oxidase. 

c. Click View Structure. Open the Cn3D structure file 
when prompted. 

PBD number: A unique identifier or 
code assigned to every entry in the 
Protein Data Bank (PDB). This unique 
code can be used to search the 
databases at the National Center for 
Biotechnology Information (NCBI) to 
find the structure of interest.

Figure 1: The Cytochrome c Oxidase – Entire Protein. 
Source: NCBI.

These commands are for navigating in the Structure Window:

• To zoom in, you can either click the letter z, or hold down the control key, left-click, and move your 
mouse/fingers. To use the mouse, move the mouse towards the computer screen to make the image 
larger and away from the screen to make the image smaller. To use the keyboard, click the letter x to 
zoom out. [Note: These commands can also be found under View in the toolbar.]

• To move the structure without turning it hold the Shift key, click in the Structure window, and drag 
the structure with your mouse. 

2. Look at the overall structure of this amazing protein. 
Cytochrome c oxidase (Figure 1) spans the inner 
membrane of the mitochondria. Open the Style menu, 
choose Coloring Shortcuts, then Secondary Structure.

a. Turn the structure around to see the part of the protein 
that is normally inside the mitochondrial membrane by 
looking for the series of green alpha helices that are 
parallel to each other. 

b. Find the parts of the molecule that are located on either 
side of the membrane by looking for the tan beta sheets.

c. Open the Style menu; choose Coloring Shortcuts, and 
then Molecule.

d. Each of the different protein chains and all the other 
molecules in the structure will be shown in a different 
color. 

e.	The amino acid sequences of each of the protein chains 
are shown in the Sequence/Alignment Viewer window, 
and are color-coded the same as each protein chain.

3.	Create a new word processing document to use as 
your answer sheet. Give the document a title, such as 
“Cytochrome c oxidase,” and add your name. 

4.	Within Cn3D, open the File menu and choose Export 
PNG to export an image of the entire cytochrome c oxidase 
protein, and save this image to your desktop. 

Alpha helix: A common structure of 

proteins, characterized by a single, 

spiral chain of amino acids stabilized by 

hydrogen bonds between neighboring 

amino acids. [Note: “Alpha helices” is the 

plural form.]

Beta sheet: A structure that occurs in 

many proteins and consists of two or 

more parallel adjacent polypeptide chains 

arranged so that hydrogen bonds can 

form between the chains.
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5.	On your answer sheet, insert your protein image. From the 
Insert menu, select Picture, and select your protein structure 
image from your desktop. 

6.	On your answer sheet, add a title to the image of the entire 
protein, “Cytochrome c oxidase – entire protein.”

7.	On your answer sheet, note how many protein chains are in 
this structure. (All the chains can be viewed in the Sequence/
Alignment Viewer.)

8.	This structure happens to be a dimer (a protein made of two 
subunits called monomers). In your document, describe how 
many protein chains are in each monomer. [Hint: The two 
monomers are identical.]

9.	Examine the iron and copper molecules bound to the 
protein. These elements play an important role in the 
protein’s function:

a. Notice the white letters used to label the metals in 
the molecular structure itself (not in the Sequence/
Alignment Viewer). 

b. If you do not see labels for the metals, open the Style menu 
and choose Edit Global Style. Then, click the Labels button, 
check the box for Metal ion labels, click Apply and Done.

c. To see the heme group and other metals more easily, 
open the Style menu and choose Rendering Shortcuts 
Ú Tubes. 

d. Open the Style menu and choose Coloring Shortcuts 
Ú Element.

e. Zoom in and find a copper ion (Cu) located close to an 
iron ion (Fe). 

f.	The iron is part of a structure called a heme that is involved 
in binding oxygen (heme groups are also found in red blood 
cells in the molecule hemoglobin). The heme group looks 
like a big net with the iron atom in the center.

g. Double click on the iron (Fe). It will turn yellow – as will the 
entire heme surrounding it. 

h. Hold the Shift key down and double click the copper 
ion (Cu). It will also turn yellow. Both ions should now be 
selected (see Figure 2).

i.	Rotate the protein and notice the space between the Fe 
and the Cu ions. This space will be important later!

Dimer: A structure made of two subunits 

called monomers.

Monomer: A molecule or subunit that 

can combine with others of the same 

kind to form a polymer. “Mono” means 

“one” and “poly” means “many.”

Iron: Iron is a metal element whose 

symbol is Fe. The atomic number for iron 

is 26. 

Copper: Copper is a metal element, 

whose symbol is Cu. The atomic number 

for copper is 29. 

Elements: Elements are pure chemical 

substances consisting of one type of 

atom. Each element is distinguished by its 

atomic number. All the elements are listed 

in the periodic table.

Heme: A non-protein compound that 

contains iron and is vital to the function 

of the cytochrome c oxidase complex.

Hemoglobin: Iron-containing protein in 

red blood cells that carries oxygen.

Figure 2: Oxygen Binding Site of Cytochrome c Oxidase. 
Source: NCBI.
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10. Open the File menu and choose Export PNG to export an image of the structure, including the area with 
the Fe and Cu. Insert your image into your “Cytochrome c oxidase” document. Label the image “Oxygen 
binding site of cytochrome c oxidase.”

Optional Extension Activity: Looking at Amino Acids that are Part of the Active Site
If time permits, an optional extension is provided below. Otherwise, proceed to Part II.

11. If not already selected, select the heme and the copper in the active site by clicking them with the mouse.

12. Open the Select menu and choose Select by Distance.

a. Set the distance at 3 angstroms and click OK. 

b. Expand the Sequence/Alignment Viewer window by clicking in the bottom right corner and dragging it 
until the window is larger. You should see some of the residues become highlighted in one of the protein 
chains in the Sequence/Alignment Viewer window.

c. Scroll through the Sequence/Alignment Viewer to see which amino acid residues became highlighted.

13. In your document, describe which chain(s) contains the highlighted residues.

PDB Position: “PDB” stands for “Protein 

Data Bank.” The “PDB Position” is the 

position of a particular amino acid in a 

polypeptide chain.

14. In your document, describe which amino acid 
residue(s) were highlighted. Make a list of these 
amino acid(s) (by their single-letter code) and their 
positions (PDB position). To determine the position, 
place your cursor over the amino acid and read 
the PDB position in the bottom left corner of the 
Sequence/Alignment Viewer. 

15. Find out which amino acids are bound to copper.

a. Open the Select menu and choose Show Selected 
Residues. You will see the heme, the copper, and the 
amino acid residues from the protein chain that binds 
these substances. [Note: You may need to zoom in or 
out to see these in the protein structure.]

b. Open the Style menu and choose Rendering Shortcuts, then Ball and Stick.

c. Click your mouse inside the Sequence/Alignment Viewer to deselect the highlighted residues.

d. You will see metal bonds (white) between the copper or the iron and some of the amino acids.

e. Select the bound amino acids with your mouse and look for the highlighted amino acids in the Sequence/
Alignment Viewer to identify the names and position numbers for those amino acids.

Carbon	
  =	
  Black	
  
Nitrogen	
  =	
  Blue	
  
Oxygen	
  =	
  Red	
  
Sulfur	
  =	
  Yellow	
  

	
  
f. In your document, record the names and PDB position numbers for 

any amino acids bound to copper.

16. Open the Style menu and change the Coloring Shortcut to Element 
(if it is not already selected). In your document, note which element forms 
an ionic bond to copper.

17.  On your answer sheet, explain whether this is the same element for all 
of the bound amino acids.
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PART II: What Killed the Victims?

The copper ion (Cu) and the iron (Fe) that you looked at in Part I are 
both important for cytochrome c oxidase activity. During the process of 
extracting energy from food (specifically, oxidative phosphorylation), 
molecular oxygen (O2) binds to the iron. If other substances are bound to 
the iron, they can block binding by the oxygen, inhibiting the activity of 
the enzyme. Your job is to determine whether there are other substances 
bound to the active site in the structures from the crime scene.

Oxidative phosphorylation: 

The process of using oxidation 

to provide energy for adding 

the phosphate groups in 

ATP. This takes place in the 

mitochondria.

18. Find a structure file from one of the victims.

a. Your teacher will assign you one of the victim’s structures (Carl North or Carol Olds) to download. 

b. Record the name of your assigned victim on your answer sheet.

c. Download the appropriate structure from the NWABR Bio-ITEST website (http://www.nwabr.org/
curriculum/advanced-bioinformatics-genetic-research) and open it in Cn3D as directed by your 
teacher. 

19. Open the structure in Cn3D. When you first open the file, it will look confusing. That is because 
there are two structures layered on top of one another. One of the structures is from a “normal” 
individual and one is from a victim. 

20. Simplify the view by opening the Style menu and choosing Coloring Shortcuts Ú Element.

21. To view the structures one at a time, click in the Structure window and then click the right arrow 
on your keyboard.

22. Next, click your left arrow.

23. Toggle back and forth (i.e., alternate between the left and right arrows) until you can see the 
difference between the two structures. There should be something new between the Fe and the Cu 
ions in the victim. You can see this even more clearly by doing the following:

a. Use your mouse to double-click the iron (Fe) and copper (Cu) from one of the structures. Note that 
the whole heme will be selected when you double click the iron (Fe). You need to be holding down 
the Control (or Command) key to select both ions.

b. Toggle to the other structure and double-click the Fe and Cu there, too.

c. Find the structure that has a molecule between the Fe and Cu. Be sure to double-click the 
molecule between the Fe and Cu in that structure.

d. Open the Select menu and choose Show Selected Residues.

e. Use your arrow keys to toggle back and forth between the normal version of the protein and the 
version from the crime scene.

f. To make the yellow highlighting go away, and to return the elements to their appropriate color, 
double-click the heme, copper, and additional substance in the Structure window.
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24. Export a PNG image of the cytochrome c oxidase active site showing the heme, 
iron (Fe), and copper (Cu) from the victim and import it into your document. 
Label the image with the name of the victim (Carl North or Carol Olds).

a. Use the element color coding to identify the small molecule between the 
iron (Fe) and copper (Cu). In your document, explain what you found and 
how you made your conclusions.

b. Look this molecule up in Wikipedia (http://www.wikipedia.com) to find 
out whether it could be used as a poison.

Carbon	
  =	
  Black	
  
Nitrogen	
  =	
  Blue	
  
Oxygen	
  =	
  Red	
  
Sulfur	
  =	
  Yellow	
  

	
  

25. Add a second label to the image. Label the image in your document “(Name of your poison) bound to the 
oxygen binding site of cytochrome c oxidase.” 

26. Underneath the image, write a few sentences about the properties of the poisonous substance and propose a 
theory to explain how it could have been administered to the victim. Add your name, date, and class period to 
your answer sheet and save it as directed by your teacher.
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LESSON 5
KEY

Molecular Murder Mystery
Teacher Answer Key5
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PART I: Investigating the Active Site of Cytochrome c Oxidase

5. On your answer sheet, insert your protein image. From the Insert menu, select Picture, and select your protein 
structure image from your desktop. 

6. Within your document, add a title to the image of the entire protein, “Cytochrome c oxidase – entire protein.”

See Figure 1.

Figure 1: The Cytochrome c Oxidase – Entire Protein. 
Source: NCBI.

7. On your answer sheet, note how many protein chains are in 
this structure. (All the chains can be viewed in the Sequence/
Alignment Viewer.)

26 Protein chains.

8. This structure happens to be a dimer (a protein made of two 
subunits called monomers). In your document, note how 
many protein chains are in each monomer, if the monomers 
are identical.

13 Protein chains.

10. Open the File menu and choose Export PNG to export an 
image of the structure, including the area with the Fe and 
Cu. Insert your image into your “Cytochrome c oxidase” 
document. Label the image “Oxygen binding site of 
cytochrome c oxidase.”

See Figure 2.

Optional Extension Exercise:

13. In your document, describe which chain(s) contains the 
highlighted residues.

Chain A (1OCC_A) (or Chain N, if the Fe/Cu pair in the 
other monomer is selected).

Figure 2: Oxygen Binding Site of Cytochrome c Oxidase. 
Source: NCBI.
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14. In your document, describe which residue(s) were highlighted. Make a list of these amino acid(s) (by their single-
letter code) and their positions (PDB position). To determine the position, place your cursor over the amino acid 
and read the PDB position in the bottom left corner of the Sequence/Alignment Viewer.

W126, H240, Y244, H290, H291, D364, H376.

15. In your document, record the names and PDB position numbers for any amino acids bound to copper. 

W126, H240, H290, H291.

16. Open the Style menu and change the Coloring Shortcut to Element. In your document, note which element 
forms an ionic bond to copper.

Nitrogen.

Figure 3: Victim: Carol Olds. Carbon Monoxide (CO) 
bound to the oxygen binding site of cytochrome c oxidase. 
Source: Cn3D.

Carbon	
  =	
  Black	
  
Nitrogen	
  =	
  Blue	
  
Oxygen	
  =	
  Red	
  
Sulfur	
  =	
  Yellow	
  

	
  

17. On your answer sheet, explain whether this is the same 
element for all the bound amino acids.

Yes.

PART II: What Killed the Victims?

24. Export a PNG image of the cytochrome c oxidase active 
site showing the heme, iron (Fe), and copper (Cu) from the 
victim and import it into your document. Label the image 
with the name of the victim (Carl North or Carol Olds).

See Figure 3 and Figure 4.

25. Add a second label to the image. Label the image in your 
document “(Name of your poison) bound to the oxygen 
binding site of cytochrome c oxidase.” 

See Figure 3 and Figure 4.

Figure 4: Victim: Carl North. Cyanide (CN) bound 
to the oxygen binding site of cytochrome c oxidase. 
Source: Cn3D.
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26. Underneath the image, write a few sentences about the properties of the poisonous substance and propose 
a theory to explain how it could have been administered to the victim. Add your name, date, and class to your 
answer sheet and save it as directed by your teacher.

Carol Olds: Carbon monoxide (CO) bound to the oxygen binding site of cytochrome c oxidase.

Carbon monoxide is a colorless, odorless, and tasteless gas and can cause fatal poisoning by inhalation. 
It binds to hemoglobin in addition to cytochrome c oxidase.

Carl North: Cyanide (CN) bound to the oxygen binding site of cytochrome c oxidase.

The binding of cyanide to cytochrome c oxidase subunit 1 prevents the electron transport chain from 
working properly, thus preventing the cell from producing ATP. Tissues such as the heart and central 
nervous system that are strongly dependent on aerobic respiration are greatly impacted by cyanide 
poisoning. When used as a poison, it is administered as a gas or a salt.

Student answers may vary as to how the poisonous gases were administered to the victims (for example, 
by exploding canister, delivery of poison-filled balloons, etc.).
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LESSON 5

Installing Cn3D5

RESOURCE

The Cn3D software allows you to view the three-dimensional structures of macromolecules like proteins and 
DNA. If Cn3D has not already been downloaded to your computer, follow the instructions below. 

1. To download the Cn3D program onto your computer, visit the Cn3D homepage at:                                  
http://www.ncbi.nlm.nih.gov/Structure/CN3D/cn3dinstall.shtml.

2. Select your Operating System (Windows or Macintosh), as shown in Figure 1.

3. Click the link to Download the Cn3D 4.3 installer here.

4. Close all internet browsers and then double-click on the .msi file, or click Run when prompted. This will 
launch the Windows Installer application if you have it already. If so, enter the information at the prompts, 
and then you are done. If not, or if Windows tells you that you need a newer version of the installer 
software, you can download the latest Windows Installer from Microsoft® by following the appropriate links 
listed on the download page for your operating system.

5. Once Cn3D is installed, you can click the link View Structure in Cn3D from any Structure page at the 
NCBI. If you are using a Mac, just double click the downloaded file and Cn3D will launch automatically.

Figure 1: Selecting Your Operating System. Source: Cn3D.

	
  


